
With CI1, everyone can enjoy 

recording sounds and creating 

music easily!

Quick Start Guide



The CI series is made up of three outstanding USB-powered audio interfaces, delivering 

a complete system solution for creating and recording music. Together with the included 

Steinberg software each unit in its own right covers a broad range of applications, be it in 

the studio, rehearsal room or on the go. 

The CI series devices have two XLR combo inputs equipped with two sophisticated 

microphone preamps and phantom power. This +48 V phantom power provides the 

capability to connect any condenser microphone, or dynamic mics, for recording vocals 

or instruments. Input 1 features a switch that allows for direct guitar input and the 

optional Yamaha BMS-10A mic stand adapter lets you attach the CI to a microphone 

stand to adjust the CI to the position that suits you best.

Flexible stereo input

Dimensions (the same for all models)  190 (W) x 45.4 (H) x 134.5 (D) mm Weight  701g (CI2+), 720g (CI2), 640g (CI1)

Stereo In/Out (two channels each)Adjusts PHONE volume level

24 bit/48 kHz max.1

TO HOSTAdjusts LINE OUT volume level USB PortMASTER Control
HI-Z Input 1 (uses INPUT 1)

Audio FormatPHONE Jack
MONO Button INPUT 1&2 can be monitored in mono

Audio specifications (the same for all models)

DAW I/OPHONE Control
Phantom Power 48V (on/off together for INPUT 1&2)

USB 1.12 (L/R) USB StandardLINE OUT JackOutput Other
Input MIC/LINE Input 2 (INPUT 1&2)

USB-bus poweredAdjusts INPUT-DAW balance Power SupplyMIX Control

Yamaha BMS-10A

mic stand adapter

Two independent input signals, such as from guitars or vocal 

performances, can be recorded at the same time.

Additionally, the +48 V phantom power supply enables you to 

use large diaphragm condenser microphones to capture studio-

quality sound.

Because the phantom power supply can also be driven by 

USB bus power, you can perform high-quality recording of a 

live stereo performance just by connecting the CI series device 

to a laptop computer.

You can create an incredible demo song by connecting the CI 

series device to the mixing console in the studio, recording the 

different parts of the music in stereo with 24 bits and at 48 kHz 

using the included software, and editing the parts using the high-

quality effects and other features.

Mobile stereo live recording

Mobile band live recording

Desktop home recording

Included software

Included software

Included software

RECORDING MADE EASY

RIGHT HERE FROM THE START THE PLUS FACTOR



CI1 General Specifications

CI1 System Requirements

OS

Included

Accessories

Net Weight
Dimensions

Power Supply USB bus-powered

PHANTOM INPUT 1&2 Turn on/off the phantom power for INPUT 1&2. (+48V, XLR-type only).

PHONES x1 Phone jack
USB x1 USB1.1, 44.1/48kHz, 16/24bit

190 (W) x 45.4 (H) x 134.5 (D) mm
640 g
STEINBERG SOFTWARE PACKAGE DVD-ROM
TOOLS for CI1 CD-ROM
USB Cable

PowerPC G5 (Intel Core Duo recommended) Pentium/Athlon 2GHz and above (Dual Core CPU recommended)

OS X 10.5.5 (Leopard), 10.6 (Snow Leopard) Windows XP Professional / Home Edition , Windows Vista, Windows 7

1024MB
1GB of free space

1280 x 800 resolution - full color
DVD-ROM drive

USB port for CI1 connection
Internet access for product registration

Operation Manual

MIX Control (INPUT-DAW) Adjusts the signal level between INPUT and DAW.

INPUT 1/2 GAIN Controls Gain for input 1/2

LINE OUT x2 (L/R) Phone jacks (1/4” TS or 1/4” TRS)

PHONES Control Adjusts the signal level sent to the PHONES jack.

MONO Button
On: Input 1, 2 signals function as independent mono channels.
Off: Input 1, 2 signals function as a stereo pair.

MIC/LINE/R x1 Combo jack (XLR, 1/4” TS or 1/4” TRS)

MASTER Control Adjusts the signal level sent to the LINE OUT jacks.

HI-Z INPUT 1 Button
On: for guitars or basses, etc
Off: for microphone or synthesizers, etc

MIC/LINE/HI-Z/L x1 Combo jack (XLR, 1/4” TS or 1/4” TRS)

Controls

Other Jacks

Output Jacks

Input Jacks

CPU
RAM 
HDD
Display

AI Knob on the CI2 and CI2+ is an innovative “point and control” 

precision controller. When you move the mouse over the parameter, 

it is then automatically placed under full control by the AI Knob. The 

parameter can be locked to the AI Knob to retain control 

when the mouse is moved elsewhere onscreen.

The CI2+ is equipped with a Cubase 

transport controller. The “PLAY/STOP”, 

“REC”, “PREVIOUS”, and “NEXT” buttons 

can be used to operate playback 

and recording.

Up to six transport sequences, such as Start, Record, Stop, Return to Start Position etc., can be triggered with the 

Action Pad on the CI2 and CI2+ console or via a connected Yamaha FC5 footswitch (sold separately). This lets 

you control Cubase with one finger, or hands free with the optional FC5, while playing an instrument. The transport 

sequences can be chosen from a list of templates or freely customized. This Interactive Recording functionality 

provides freedom of movement and doesn’t get in the way of your creative flow.

CI2 and CI2+ both feature plug-and-play support. Once the software is installed and the 

hardware connected, Cubase (series ver. 5.1 required) detects and automatically embeds 

the CI2/CI2+ into the Cubase production environment. Visual feedback is provided through 

the “AI Ready” LED. When it lights up, CI2/CI2+ is ready to assume control.
* requires version 5.1 or above of Cubase 5, Cubase Studio 5, Cubase Essential 5, and Cubase AI 5.

The CI series devices are fully powered by your computer’s USB port. Simply connect CI series to a USB 

port (more effective on the computer itself and not a peripheral like a USB port on a keyboard) and there’s 

sufficient power to connect two professional +48 V condenser microphones.

Cubase Essential 5 is based on the same 
VST audio engine as Cubase 5. High-grade 
features that are essential to tasks such as 
creating songs, recordings, and podcasts have 
been carefully selected and combined into a 
compact package. Cubase Essential 5 offers 
Pitch Correct, a pitch correction plug-in, Beat 
Designer, a tool that enables you to create 
rhythm parts immediately, the HALion ONE 
VST instrument and the Prologue virtual analog 
synthesizer.

Cubase AI 5 is a special version of the 
software that is based on the same technology 
as Cubase 5 and is included with Steinberg 
and Yamaha hardware. Cubase AI 5 offers 
the basic features that are necessary for 
creating music, such as a Project Assistant 
feature, which quickly gets you ready to make 
music, even if it's your first time, as well as the 
AmpSimulator effect, and HALion ONE.

CI1 includes Sequel LE, which can be used to 
create songs, and WaveLab LE 7, which can 
be used to record and edit audio. Sequel LE 
comes with an extensive loop library, instrument 
sounds that can be performed immediately, 
and fascinating effects. WaveLab LE 7 can be 
used to edit recorded sounds and create audio 
CDs. The combination of these two programs 
lets you create music and edit sounds as you 
please.

Transport Control

AI Knob

Interactive Recording

Action Pad

AI Knob

Easy setup and “AI Ready” LED

USB-powered

Bundled Software
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My computer is at the center of my musical life

When I want to listen to my favorite music while I’m on the move, I copy music from my audio 

CDs to my computer, and then transfer this data to my portable music player. Lately, it’s become 

common to just purchase downloaded music from the Internet, skipping the step of buying audio 

CDs entirely. In other words, my musical environment is completely digital.

This system is fine if you only want to listen to music, but it’s not quite enough for me.

There are two things that I want to do

(1) I want to convert analog sources such as records and cassette tapes to digital data.

(2) I want to create music, not just listen to it.

I’m sure I’m not the only one that wants to be able to do these things. It’s all well and good to just 

buy CDs to replace your old analog records, but this isn’t possible if the band wasn’t popular 

enough to merit a re-release in the new digital format. And then there’s the matter of all the tapes 

that you’ve filled with music recorded off the radio.

On top of this is the desire to create one’s own music. On occasion, I’ve played a little guitar and 

hummed along to make a tune, but that isn’t what I’m talking about. I’m talking about wanting to 

create a complete song and then presenting it to other people. And of course, it has to rock!

I told a friend of mine who is knowledgeable in this area about what I want to do. He told me 

that I would need:

• Music creation and editing software

• An audio interface

That makes sense.

To write documents, you need word processing software. To edit pictures, you need image editing 

software. It makes perfect sense that you would need “music creation and editing software” to 

create and edit music.

So, what's an "Audio Interface"?

When I asked my friend this question he replied, "it's a device that is used to record and play back 

music." If that's all, my computer already has that functionality, doesn't it? You know, it's that thing 

called a "sound card". When I told my friend as much, he replied:

"The sound card that's included in your computer is only good enough to produce the sounds 

used in videogames and to play back a CD. It's insufficient to record sounds that are produced 

outside of the computer. In other words, your sound card can't record sound with good quality. 

Even the microphone input isn't designed for recording music so you just can't get good quality 

recording."

Hmm. Let me rethink my goals again. I would like to:

• Keep the analog records and cassette tapes that I have in my home in 

digital format.

• Create accompaniments for my original music.

• Record guitar and vocal tracks along with these accompaniments.

In addition, I would also like to:

• Edit recorded music, such as removing noise and adjusting levels.

     If I'm going to keep my music, I'd like to keep a version that sounds as 

clean as possible!

• Easily create cool-sounding music without having to learn complicated 

music theory.

• Make the guitar and vocals sound good.

     It'd be great if there are effects, such as reverb, that I can use.

To put it simply, I want a device that lets me do everything that is possible in a recording studio.
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That's all I have to pay to get the same features as a 
recording studio?

When I asked my friend about what I need to buy to get what I want, he replied, "You can buy 

something that will meet all your needs for about 100 US dollars."

"You're kidding me! It's really that cheap?" I asked.

"I recommend that you buy the CI1 audio interface. It was made by Steinberg, a world-famous 

manufacturer that is located in Germany and has been producing music creation software and 

hardware for more than 25 years. Steinberg's products are also used by professional musicians 

and sound engineers," he said.

More than 25 years, huh? That's more than a quarter of a century. That means that the company 

has a long history and a strong brand image. Wait just a minute. What about the software? The 

audio interface is cheap, but I bet that means the software is expensive!

To confirm my suspicions, I asked my friend.

"It's included with the audio interface."

"You're pulling my leg."

"Look, I'm telling you that the software that you need to create and edit music is included with this 

audio interface at no extra cost!"

What's more, it's simple to connect the CI1 to 

your computer—all it takes is a USB cable!

The figure on the right gives a rough example of 

the type of systems that you can build.

So, that means that I can immediately do exactly 

what I want if I just purchase this CI1 audio 

interface. Sounds great! Let's get started!

This is the CI1

It's an audio interface, like those that I've already 

described. To use the CI1, just connect it to your 

computer using the included USB cable.

Let's check the I/O jacks

• Input jacks
These jacks receive audio from external sources. The CI1 has two input 

jacks that can receive stereo signals from devices such as record players 

and cassette decks.These jacks can also receive mono signals from 

sources such as guitars or vocals.

The jacks accept both phone jacks, which are widely used in the outputs of electric guitars and 

synthesizers, and XLR jacks, which are used in the outputs of microphones that meet professional 

specifications. There are other audio interfaces that only allow you to connect one type of jack 

or the other, but not the CI1! The CI1 is equipped 

with "combo jacks", useful jacks that enable you to 

connect either phone or XLR jacks.

The output jack that is most commonly used in 

record players and cassette decks is the RCA jack. 

An RCA jack must be converted to a phone jack 

before you can connect it to the CI1. You can find 

these adapters at your local electronics store.

• Output jacks
The CI1 has LINE OUT jacks that provide stereo output through a pair 

of phone jacks and a PHONES jack that provides headphone output.
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TIPS！

Controller

• GAIN, for adjusting the input sensitivity when 

recording external sound

There are two GAIN knobs for adjusting the input sensitivity 

and one knob for each of the input jacks. These knobs 

determine the volume level of the input signals when they 

are recorded to your computer.

• HI-Z button, used when connecting electric 

guitars to the CI1

When you connect an electric guitar or an electric bass to 

INPUT 1, press the HI-Z button, which is located above the 

INPUT 1 GAIN knob, before you begin recording. Note that 

you will not be able to record electric guitars or basses if you 

do not press this button.

• MASTER knob, for adjusting the LINE OUT jack volume

This knob adjusts the volume level of speakers or other connected devices.

• PHONES knob, for adjusting the PHONES 

jack volume

This knob adjusts the volume level of the headphones.

• MONO button, for switching between stereo and 

mono signals

By default, the CI1 handles stereo signals. When you want to record 

mono signals from sources such as guitars or vocals, press this MONO 

button.

• PHANTOM button, for supplying power to condenser 

microphones

There are two types of microphones: dynamic 

and condenser. At professional vocal recording 

sess ions ,  condenser  m ic rophones  a re 

commonly used. Condenser microphones 

require "phantom power". When you use 

condenser microphones, be sure to press this 

button to supply phantom power.

DAW is an acronym for Digital Audio Workstation, which is just another way of saying 

"music creation software".

• MIX knob, for balancing the input signal and the sound 

being played back from the computer

This knob lets you select which sound to 

listen to during recording. For example, 

when you are recording vocals and want 

to listen to the sound from the microphone 

that is connected to the input jack, turn the 

knob toward INPUT. If you want to hear 

the vocals after applying an echo or other 

software effects, turn the knob toward DAW.
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What sort of software is included?

The following software is included with the CI1.

WaveLab LE 7

This is the light edition of the WaveLab series, software that is popular among professional sound 

engineers and musicians as a top-class audio editing tool that provides level adjusting and noise 

removal features. This software not only enables you to copy music from audio CDs, it can be 

used to record external audio, and it also provides 

you with a host of easy-to-use, professional-quality 

editing features, such as a feature for displaying 

and editing audio as waveforms.

Sequel LE

This is the limited edition of Sequel 2, software that enables even those who have no knowledge 

of difficult music theory and have never played an instrument to easily create their own music 

by arranging loops (files that contain musical parts) that have been created by some of the 

world’s foremost professional musicians. This software enables you to not only record guitars and 

vocals, but also to freely use the included effects to 

create and adjust sounds in the same way that the 

professionals do.

To specify the CI1 as an audio device

• WaveLab LE 7
Start WaveLab LE 7, click "Options" and then "Audio Streaming Settings" to display the "Audio 

Streaming Settings" dialog box. Click "Audio Device", 

select "Yamaha Steinberg USB ASIO", and then click 

"OK".

How do I install the included software?

I heard that Steinberg is a German company; this doesn't mean that the installation language is 

German, does it? You don’t need to worry about this at all. Insert the included DVD, "STEINBERG 

SOFTWARE PACKAGE FOR CI1 DVD-ROM" into 

your computer's DVD drive. A guidance dialog box will 

appear, followed by a screen on which you can select the 

installation language. Select the flag that corresponds 

to the language that you want to use. Buttons labeled 

Sequel LE and WaveLab LE 7 will appear on the next 

screen, so let's click these buttons to install both of 

these programs!
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TIPS！
 
 

• Sequel LE
Start “Sequel LE 2”, click the "Program Settings Page" icon in the lower left of the screen and 

then "Audio Connection". Then select "Yamaha Steinberg USB ASIO". A dialog box will appear 

with the message "Do you want to switch the ASIO driver?" Click "Switch".

ASIO is an acronym of “Audio Stream Input/Output” architecture. To put it simply, this is 

the key factor to make creating music on computers more enjoyable, because this driver 

enables very fast communication of audio data between the computer and the software. 

ASIO technology was also proposed and developed by Steinberg, and is very popular 

standard among countless audio manufacturers worldwide.

Use WaveLab LE 7 to capture the music on a record

Let's try to capture the music on an analog record! By the way, the output signal generated by a 

record player is incredibly small. Therefore, if you connect the output of a record player directly to 

the CI1, the music that you record may not have a suitable volume level. Use a phono preamp to 

amplify this signal. In some stereo combo systems, the phono preamp is built-in to the amplifier. 

There are also record players with built-in phono preamps. You can also purchase a stand-

alone phono preamp. Read your record player's instruction manual carefully before preparing and 

connecting the phono preamp to the player.

In the example to follow, we use an amplifier that has a built-in phono preamp and connect that 

amplifier's line-out to the CI1.

How to connect a record player to the CI1

Note: The output jacks of each device are RCA 

jacks, so you have to use adapter cables as 

described on page 8.

Analog record player

(with phono preamp)

Analog record player

(without phono preamp)

Analog record player

(without phono preamp)

Power amplifier

with phono preamp

Stand-alone 

phono preamp
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TIPS！
The audio CD format settings are as follows: set "Channels" to "Stereo", "Sampling rate" to 

"44 100" (Hz), and "Accuracy" to "16 bit".

Starting WaveLab LE 7

After you connect the record player to the CI1, double-click the 

"WaveLab LE 7" icon on the desktop.

On the "File" menu, click "New".

The "Audio Properties" dialog box will appear. Our final goal for this example is to make an audio 

CD, so leave the settings at their default values, and then click "OK".

Checking the volume level of the recording

Next, click the Record button to display the "Recording" dialog box. Begin playing a record on the 

record player, and the level on the volume meter in the center of the dialog box will move.Adjust 

the volume so that the level does not exceed 0dB.

Use the CI1 INPUT 1&2 GAIN knobs to adjust the 

volume.

After you have finished making adjustments, click 

"Record" on the "Recording" dialog box, and then return 

the record player's needle to the beginning of the record 

to play the music that you want to record.

All that's left to do is wait for the recording to complete. 

When the part that you want to record is finished, click 

the "Stop" button. Then, click the "Close" button to 

complete the recording.



1817

Chapter 5

Edit the recording - step 1: Delete unnecessary parts

When the recording is complete, the recorded sound is displayed as a waveform.

The waveform is displayed in two parts of the screen. 

The upper part displays the entire waveform. The 

lower part is used to actually edit the waveform. On 

either display, the more you move to the right, the 

more you move forward in the waveform's time. The 

time unit on the top display is mn (minutes). The 

unit on the bottom display is s (seconds).

The amplitude of the wave corresponds to the 

volume level of the recorded sound. When the amplitude is large, the volume is high. When the 

amplitude is small, the volume is low.

From the waveform display, you can see that there was a period of approximately 4 seconds at 

the start of the recording where there was no sound. Following that, the sound of the needle 

first touching the record was recorded with a slightly high volume level. The actual song begins 

a little after the 6 second mark, after the characteristic noise caused by the needle touching the 

record.

Click the Play button to play back the recording. 

Carefully check what section is noise and where 

the actual song begins.

First, let's delete this noise and the part of the 

recording that doesn't have any sound.

Drag the pointer from the beginning of the song to 

where the song actually begins.

On the "Edit" menu, click "Remove". This is all you have to do to delete the part that you don't 

need.

Let's edit the last part of the song as well.

Drag the scroll box to the right to display the part 

after the end of the song.

It's easy to see that noise was recorded during the time between the song ending and the needle 

returning to its rest position as well as when the needle lifted off of the record. You don't need 

these parts, either, so drag the pointer to set the range that you want to delete, and then on the 

"Edit" menu, click "Remove".

You now have a song without any unnecessary parts.
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WaveLab LE 7 has a gain normalizer, a feature that automatically increases volume levels while 

ensuring that they do not exceed this peak level. Let’s give it a try.

On the “Processing” menu, click “Level Normalizer” to display the “Normalize level” dialog box. 

Leave the default value of 0.000 dB under “Peak level after execution” as it is, and then click 

“Apply”.

Edit the recording - step 2: Adjust the overall volume level

You used the CI1 GAIN controls to carefully set the volume level, but if you look at the waveform, 

you can see that the overall volume level is low. You may think, "Oh no! I'll have to record the 

song again". Don’t worry. You can adjust the volume level of the whole song even after it has 

been recorded!

When adjusting the volume level of the whole song, you just have to make sure that no parts 

exceed 0 dB, which is the peak level over which the signal becomes distorted. The vertical center 

of each waveform display is marked as ∞ (dB), and 0 dB is marked both above and below this 

value. All you have to do is increase the volume and ensure that it stays within these 0 dB limits.

Let’s compare waveforms before and after gain normalization. The difference is very clear. If you 

play back these waveforms, you’ll also be able to notice the difference in their volume levels. 

What’s more, WaveLab LE 7 automatically makes adjustments so that the sound does not 

become distorted even when the volume is increased. Simple, isn’t it?

Saving the edited song

Now that you've removed the noise and adjusted the volume to a suitable level, let's save the 

song that you've recorded.

• Saving the song as a .wav file

On the "File" menu, click "Save as" to display the "Save Audio File" dialog box.
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The song should have been saved to the desktop as a .wav file. You can listen to this file in 

Windows Media Player or Quick Time Player and use the file to create an audio CD.

But, don't make the audio CD until after you've read PART 9!

Previously, we have selected the file format under the assumption that we will burn this song to 

an audio CD, so "Output Format" should be set to the familiar CD format. Even if you want to 

compress the song to MP3, saving the song to a .wav file (CD format) will give you flexibility later. 

For this reason, we recommend you save the song as a .wav file.

Enter the name of the song for the "File name". We'll enter "Spanish Fly", the name of the song 

on the record. "Folder" specifies the location where the file will be saved. Here, we'll specify the 

desktop so the file is easy to find. After you have set the file name, folder, and the output file 

format, click "Save".

Let's try using Sequel LE to make a song!
 

This time, let's try to make an original song. What's that? You say you don't know the first thing 

about the theory behind making a song? No problem! The software—that is to say, Sequel LE—

will take care of all the hard parts. There are some rules that you need to remember, but these are 

rules for how to use the software. It's no different from learning to use a word processor or any 

other program on your computer.

Start Sequel LE and play back the demo song

First, let's start the software and listen to a demo song. Double-click the 

Sequel LE 2 shortcut icon.

The software will start, and it will begin to load data. It's loading the demo 

song. In the Sequel series, songs are referred to as "projects". That's why the dialog box 

message says "The demo project is read-only". In other words, this is telling you that you 

can only listen to this project. Let's hear just what kind of song it is. Click "OK" to close the 

dialog box.

Next, another dialog box will appear that begins with the message "Sequel LE is...”. This 

message prompts you to register the product. Right now, we want to listen to the demo song 

right away, so click "Cancel". We recommend that you register the product later, because this 

will enable you to receive e-mail newsletters that have information about Steinberg products, 

and other services such as upgrade and support.
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Explanation of the parts of the screen

"Tracks" are listed on the left side of the screen. An icon of an 

instrument is displayed beside each track. Each track contains 

data from a musical instrument.

A "mixer" is displayed at the bottom of the screen. The mixer is 

used to adjust the volume of each track, that is, of each musical 

instrument. During playback, the bars of the meters rise and 

fall to display the volume level of the different tracks. Drag the 

channel level knob down to decrease the volume level and up to 

increase the volume level.

As a song is played back, you can see that its waveform is displayed. This is the same type of 

waveform as the audio waveform that you saw in WaveLab LE 7. In other words, these tracks 

contain audio data.

Click the Play button in the upper right of the 

screen to begin playing the song. It sounds 

really good, doesn't it?

This audio data is called a loop. Loops contain parts made by professional musicians. Because 

loops already contain amazing parts, anyone can easily make great-sounding music just by 

arranging loops.

There are also tracks that show musical instrument 

tones instead of waveforms (loops). If you double-

click the data in the "Square Lead" track that is 

currently shown at the bottom of the display, a 

keyboard and something that looks like a graph will 

appear where the mixer was previously displayed. 

You can enter the pitch, length, and strength of sounds to enter your own melody.

Now that you understand the Sequel LE screen, let's actually make a song!

Arranging loops in a new project to make an 

accompaniment

In this section, we're going to actually make a song. 

But, it's incredibly difficult to make a song from 

scratch. So let's first make the accompaniment—

the framework using drums, bass, and other 

instruments—and then create the melody.

• Creating a new project and 

configuring its settings
Click the project menu and then "New Project".

The demo project's tracks and mixer will be 

removed, and a new project that is completely 

empty will open.
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At this point, we'd like to focus your attention on the 

key at the top of the screen. Currently, it is not set 

to a value, so "-" is displayed. You can think of the 

key as the "Characteristic pitch of the song" or “The 

main note in the melody”. Even if you leave the key set 

to no value, you can still make a song. But, the parts 

contained in the loops have been played in different 

keys. If you do not consolidate to a certain key, you will 

end up making a strange song with instruments played 

in different keys. For the moment, set the key to "A".

• Searching for a drum loop
When making a song, it's easiest to first decide on 

the rhythm, that is, the drum part. To search for a drum 

loop, click the icon in the lower left of the screen 

("MediaBay Page") to open the "MediaBay" page. This 

page is used to search for loops.

A variety of instruments, such as Accordion, Bass, and 

Brass, are listed under the "Category" heading. First, 

we want to search for drums, so click "Drum&Perc" 

(drums and percussion). Next, select the type of part 

or tone that you want from those listed under the "Sub 

Category" heading to the right of the Category list. For 

this example, let's select "Beats".

This will narrow down the list of drum loops that 

are displayed on the right side of the screen to only 

performances of patterns. Try clicking one of the 

entries. The selected drum pattern is played back. By 

clicking on different names of loops and playing them 

back, you can search for the drum loop that you want 

to use.

Drag "Rush" to the position labeled as "1". "1" is the first measure. This means that it is the start 

of the song.

Just like when you were working with the demo project, the track is created, and the loop's 

waveform is displayed.

That's all it takes to create the drum track. Easy, isn't 

it!?

• Now let's make the bass track
Now that the drum track is complete, let's make the bass track. Let's choose this from the list 

of loops as well. Under "Category", select "Bass", and under "Sub Category", select "E.Bass". 

"E.Bass" is short for electric bass. From the list of 

loops, choose "Funk City". Drag this loop to the first 

measure, under the drum track.

Play back your song, and give it a listen! The bass is 

played together with the drums. See? It didn't take 

long at all to make something cool!

• Let's toss some piano in there

I'm sure that you know what to do by now. Next is the 

piano. Let's use some E.Piano (electric piano) for this 

one. Under "Category", select "Keyboard", and under 

"Sub Category", select "E.Piano". From the list of 

loops, choose "Acid Jazz City". Drag this loop to the 

first measure, under the bass track.
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• Use the "Duplicate" feature to repeat these parts
OK. Now we have our three parts: drums, bass, and electric piano, but, at the moment they only 

last for four measures. That's hardly enough to call this a song. To make the parts longer, let's use 

the "Duplicate" feature.

Drag the pointer to select all the loops.

On the "Edit" menu, click "Duplicate".

A copy of the selected loops is created and placed 

next to the existing parts so that it starts from the fifth 

measure.

Let's do the same thing again to repeat the loops 

up to the end of the twelfth measure. Now we have 

something that more closely resembles a song!

With this, we have finished creating our accompaniment—the framework of the song.

Next, let's try recording guitars and vocals!

Record an electric guitar

Sequel LE doesn't just let you create loop accompaniments; it can also record audio. Why don't 

you grab your electric guitar and give it a try? What's more, Sequel LE has features that ensure 

you can make awesome sounds just by connecting your guitar.

• Connecting your guitar to CI1 and creating tracks
Use a phone cable to connect your guitar's output 

to the CI1 1/L jack.

Press the HI-Z and MONO buttons

On the "Edit" menu, click "Add Track".
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The "Add new track" dialog box will appear. Under 

"Category", select "Guitar/Plucked", and under 

"Name", select "Bluesman". Next, click "OK". 

Selecting "Bluesman" will give your recording an 

intense sound like that of a rock guitar.

The "Bluesman" track will be created. Check that 

the Record Ready button that displays a circle 

(enable and disable recording to the track) in the 

lower left of the track is lit in red. If it is not lit, click 

this button.

Next, let's configure the input device settings. You 

have to set which of the two input signals the CI1 

will record.

The input device settings are hidden by default, 

so let's display them. Click the rightmost "Track 

height" icon, or the second "Track height" icon 

from the right to increase the track height.

Click "Stereo In", and then select "Steinberg CI1 - 

1" from the menu.

With these settings, play the guitar while performing 

adjustments with the CI1 INPUT 1 GAIN knob to 

set the track's level meter to approximately 80%.

• Setting the metronome
You can click the Record button to begin recording, but if recording starts immediately, you won't 

be able to start playing in time. So that this doesn't happen, let's start with a "count off". Drummers 

often signal "one, two, three, four" with their sticks, 

right? We're going to have a metronome do this for 

us. Click the Metronome button in the upper right 

of the screen to light the yellow-green lamp and 

turn the metronome on.

When the metronome is on, recording doesn't actually start until two measures have passed 

after you press the Record button. In other words, the metronome generates eight clicks before 

recording starts, so you can get ready.

• What shall I play?
"Okay, I'm ready to go! But wait. Just what should I play?" you may be thinking. At the moment, 

the song's key is "A". And, we've selected minor keys for the bass and electric piano loops. So, 

you should play a chord, an arpeggio, or a solo in A minor.

Try playing a single chord from the start of the first measure. Of course, feel free to play anything 

you want.

Click the Record button to start recording!
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When you finish playing the song, click the Play button to finish recording.

Let's check whether we got a good recording of the guitar part. Click the "Jump to Previous 

Marker" button to return to the beginning of the song, and then click the Play button to listen to 

the recording.

Let's record the vocals!

Now that we've recorded the guitar part, it's time 

to record the vocals! The procedure is almost the 

same as for the guitar.

Connect a microphone's cable to the CI1 2/R jack. 

For this example, we're assuming that you're using 

a dynamic microphone, so there's no need to press 

the PHANTOM button.

Like with the guitar, on the "Edit" menu, click "Add 

Track" to display the "Add New Track" dialog 

box. Under "Category", select "Vocal", and under 

"Name", select "Vox-Male Dance Lead". Next, click 

"OK".

The "Vox-Male Dance Lead" track is created, so 

let's configure its input device settings as well. 

For the guitar, we set this to "Steinberg CI1 - 1", 

but the microphone is connected to 2/R, so select 

"Steinberg CI1 - 2".

Check that recording is enabled, and then adjust 

the volume level the same way that you did 

before recording the guitar part. Speak into the 

microphone, and adjust the CI1 INPUT 2 GAIN 

knob.

You should notice that a reverb effect is being 

applied to your voice so that it sounds good. It 

should be such an amazing sound that it's hard to recognize as your own voice.

• What shall I sing?
It's unlikely that you'll be able to come up with lyrics right away, so just sing "Yaah!" or "Ahhh". As 

we explained in the section for recording the guitar performance, the key of the song is A minor. 

You'll be fine if you sing the notes that correspond to the white keys on a piano. Why don't you 

try to adlib something?

Okay! Click the Record button to start recording! Just like when you recorded the guitar part, 

listen to the metronome for two measures, and then start singing!

When you finish singing the song, click the Play 

button to stop recording.

There you have it! You're original song is 

complete!

Because the recording step is now complete, turn 

the metronome off before you proceed to the next 

parts.
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Let's try to adjust each of the tracks
 

Turn the metronome off, and then give the song a listen. For a first attempt, it's not half-bad, 

right? But, if you listen closely, you can tell that the sound level of the drums is too high. On the 

other hand, the vocals can hardly be heard. This means that we should reduce the volume level 

of the drums and increase the volume level of the vocals. One more thing, doesn't it seem like 

there's too much echo being applied to the vocals? Let's adjust that as well. Performing these 

adjustments is known as "mixing", just like what the professionals do! Cool, isn't it?

Use the mixer page to perform mixing

Because we're going to perform mixing, open the mixer page, the 

screen that is designed for mixing. To open this page, click the 

"Mixer Page" icon in the lower left of the screen.

• Adjusting the volume
Raise and lower the channel level knob to adjust each channel's volume. To try 

this feature out, let's lower the channel level knob of the drum track (01 132 

Drums) all the way to the bottom. You shouldn't be able to hear the drums at 

all.

Listen to the song a number of times, adjusting the volume levels of the 

different tracks until you find a suitable balance. You can tell that you've found 

this suitable balance when you can clearly hear the sound of each of the tracks, 

you can clearly make out the beat, and the leading 

vocals can be heard in front. The volume levels of 

the guitar and vocals are different depending on 

how you recorded them, but take a look at the 

balance shown in the figure as a reference.

• Adjusting the left and right balance
People who have been to live band performances before probably know 

this, but a band is typically arranged in a certain configuration: the drums 

are in the center, guitars and keyboards are on the left and right of the 

drums, and vocalists are centered at the front of the stage. In the same 

way, by changing the position where the sound from each track comes 

from, you can create the sensation of being at a live performance in an 

open space. The parameter that is used to adjust these positions is called 

the "Panner". It's also referred to as "pan" or "pan pot” (short for panoramic 

potentiometer).

Currently, all tracks are being played from the center position, so let's adjust the pan of the 

different tracks to give the impression that this is a live band performance.

Let's move the electric piano to the left (L) and the electric guitar to the right (R).

This should create a good deal of space in the left and right directions, which should make the 

song sound much more like it is being performed by a band.

• Adjusting effects
The things that add effects to sounds are known as 

"effects" or "FX". A reverb effect was added to the 

vocals that we recorded earlier during the recording 

process, but it kind of sounds like someone's singing in 

the shower, doesn't it? Let's try to fix this.

We're going to adjust the vocal effect, so first click the vocal track to select it.
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Next, click the "Track Inspector Page" icon. Click "Track Effects" to display the screen that is used 

to adjust the effect parameters.

Here, we're going to adjust the "Mix" value, one of the “Reverb” parameters. The larger the Mix 

value, the more reverb is added. There's a little too much reverb at the moment, so let's drag this 

meter to reduce the value to 10%.

A number of different effects are included, not just reverb. Click "Equalizer" to display an equalizer 

that you can use to adjust the sound quality. Try using the equalizer to make an even better 

sound!

It's finally time to save the song to a .wav file and create 
the CD! But before we do...

Alright, we have a song that we copied from a record and a song that we created and recorded. 

Now we should be able to save these songs to .wav or some other type of audio file and create 

their audio CDs. Alternatively, we can convert these audio files to another format, such as MP3, 

and play them on a portable music player.

But before we do, there's one more step that we need to take.

Take a look at the following figures. The figure on the left is the waveform of a song from a 

commercially available audio CD. The right is the waveform of an audio file that was converted 

from a song created in Sequel LE. What do you see? The waveforms are completely different, 

aren't they?

Nearly every part of the waveform on the left reaches the upper limits, but not on the right. The 

sound of the left is more powerful, and its overall volume is louder than those of the right.

If you transferred these two songs to a portable music player or burned them to a CD, you’ll 

hear the big difference when you play them in succession. If you played the left song and then 

the right song, the volume of the latter would be so low that you'd increase the volume. If the left 

song started again, you'd have to rush to lower the volume. What a nuisance to have to deal with 

every time a different song is played! That's why we have to adjust the songs that we record and 

create so that their volume and sound pressure are the same level as the songs on commercially 

available audio CDs.

This process is known as "mastering". Let's master our songs before we save them to audio 

files.
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TIPS！

If iTunes is installed on your computer, "Save to iTunes" becomes enabled on the "Project" 

menu, and you can select this command to save a song directly to iTunes.

• Using Sequel LE to master the songs and save them to files
On the "Output Effects" page, increase the "Maximizer" effect's "Optimise" parameter. If you set 

this parameter to a value close to 100%, the volume and sound pressure will increase, but the 

sound will also take on a rough feeling. A value of about 80% should be enough.

On the "Project" menu, click "Export Project as Audio File" to display the dialog box, and then 

enter the name of the file in the "File name" box. Set the file name to "Sequel Song", specify the 

desktop as the location to save to, and then click "Save".

You'll be returned to the screen that is used to save the audio file, so let's check the parameters. 

Confirm that "File Format" is set to "Wave File" and "Export Bits" is set to "16 Bit". We mentioned 

this earlier, but these are the settings that correspond to the audio CD format.

When you are ready, click "Save".

The "Sequel Song.wav" file should have been saved to the desktop.

Open this in WaveLab LE 7, and you should see the following waveform:

Perfect! The sound pressure 

is about the same as that of 

a song from a commercially 

available audio CD. It's a 

resounding success!

Now you can enjoy listening to this file in an audio player on your computer such as Windows 

Media Player or iTunes. You can also transfer the file to a portable music player or burn it to an 

audio CD. Purchasing the CI1 means that you receive the included music creation and editing 

software programs, which make it easy to obtain a greater level of enjoyment out of your musical 

life. Why don't you give it a try?
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